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1. Report Writing 

1.1 Report writing Overview. 

Personnel Manager comes with many built in reports, which are available to use as soon as you have entered your 

employee records on to the database, however you may wish to edit the existing reports or create ones of your 

own. 

 

Reports are ideal for analysing data from Personnel Manager as data can be compared in groups showing totals 

or they can be summarised. These reports can be saved and used over again. Note: Reports are dynamic. Each 

time the report is run, it will show data as it appears at that time.  

 

Reports can be as complex as required retrieving information from one or more Personnel Manager tables based 

on complex search criteria. 

 

1.2 Creating a New Report using the Wizard 

For best results, use the Report wizard to select the data you wish to view in your report, BUT change the criteria, 

such as filters and sorting whilst Editing the report.  

 

To make changes to a report or to design a new report you must be in the report Edit Mode.  

 

The Edit mode shows 3 different views, identified by 3 separate tabs in the top right of the report window. These 

are: 

Define Search 

Layout Page 

Preview Report 

 

There are 3 main types of reports  

• A Detailed (or list) Report -  displays all detail relating to the report such as names in a simple list 

• A Grouped Report – Shows details grouped by a field in the database, E.G. a list of names by dept. 

• A Summary Report - simply calculate totals for example, headcount by department 

 

For the next few sections we will concentrate on producing a simple Detailed report which will be a list of 

employees, departments etc. 

 

To create a new basic report (List of employees and their departments): 

 

1. Click on the Reports button 

2. Click on the folder within the report explorer, where you want the report to be saved (i.e. Reports folder) 

3. Click the NEW button on the toolbar 

4. Choose REPORT and enter a name for the report in the box provided 

5. Next 

6. Choose the tables you wish to use (For example, Employee Details + 1 other table only) and click Next 

7. Choose the fields you wish to use (For example, Surname, Firstname, Department) and click Next 

8. Click Next 6 times 

9. Finish 

10. A new window will open showing the Layout Page view. Click Maximise 

11. To view the report click the Preview Report tab 

12. To SAVE and EXIT the report simply close the window and click YES to save. 

 

Once you have completed the above steps you will be required to make some aesthetic changes to the Layout 

Page of the report so that it is suitable for printing. These will be discussed in the following sections. 
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1.3 Define Search tab Overview 

The Define Search Tab is where we make changes to the actual data, which will appear in the report, and is where 

we set up Sort orders, Filters etc 

 

In addition to a toolbar, you will notice in the top half of the screen with at least one box displayed, which should be 

called MASTER. In some cases (depending on which screens were chosen when setting up the report), a second 

box (table) will be shown with a line between the two. 

 

In the bottom half of the screen you will see the FIELD GRID which displays various properties relating to your 

chosen fields, the first of which should be the HEADER and this describes which fields have been chosen for use 

in this report. 

 

From here we can do a number of things, such as add another field to the report or edit the properties of the 

chosen fields. 

 

Using a simple report such as the one created in section 1.2 we will add extra fields to the report and edit the 

properties for some of these fields, for example we will change the sort order and add a filter. 

 

1.3.1 To add another field for use in the report 

 

1. Click on the Box (Table) called MASTER 

2. Scroll down the list of fields until you find JOB TITLE 

3. Double click on JOB TITLE and it should appear in the bottom half of the screen 

 
NOTE: This will not automatically add the field in the LAYOUT PAGE TAB and therefore will not be 
displayed automatically within the report. If you want this field to appear on the report, then you need to 
add it using the PAGE DESIGNER within the LAYOUT PAGE TAB 

 

1.3.2 To change the sort order to Surname, Firstname: 

 

1. In the bottom half of the screen find the word FIELD down the left hand side of the ‘field grid’. 

2. Then move the mouse pointer to the right until you find the Surname field.  

3. Double click 

4. This will open the Properties dialogue box which will enable you to change the properties for the 

Surname Field (NOTE: If you double click on the HEADER row, you may not have opened the correct 

field Properties to make sure, Check that the properties dialogue box is called EDIT 

MASTER.SURNAME). 

5. Change the SORT property from NONE to A-Z by clicking on the dropdown list and selecting the A-Z 

option 

6. Click OK and the SORT option on the Report window should now show A-Z for the Surname field. 

7. Repeat this process for the Firstname field 

8. Click on the preview report tab to view the results 

 

It is important to ensure when sorting by different fields, that they appear in the ‘grid’ in the Define Search tab in 

the order in which you want them to be sorted. For the above example, Surname will need to appear before 

Firstname. 

 

To change the order of precedence of these fields, simply click on the HEADER for each field you wish to move 

and drag to the left (or right) and let go of the mouse when the field is in the correct position.  
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NOTE: This will not change the positions of the fields on the actual report! 

 

 

1.3.3 Setting up a filter within the report 

 

You may wish to only view a selection of data within you report rather than show all the available records, for 

example you may wish to show only the employees within a particular department or of a specific Gender etc. 

 

To do this you will need to set up a filter within the field you wish to search on. In this example we will search for all 

the Males within the company. 

 

Firstly we will need to add the Gender field to the field grid, within the Define Search tab by finding GENDER from 

the MASTER table and double clicking. 

 

GENDER should now appear in the Field Grid. 

 

To add the filter: 

 

1. Open the Properties dialogue box for the Gender field (by finding the FIELD called GENDER and double 

clicking) 

2. On the right hand side of the properties box, you will see a drop down box. From here choose the IS 

EQUAL TO filter.  

3. Below the drop down are 5 empty boxes. In the first empty box type in the word Male (it is critical that 

this is spelt correctly whilst using the correct case) 

4. Click OK 

5. Click on the Preview Report tab to view the results 

 

 

Other Filters 

 

The following is an explanation of the different kinds of filters available and examples of where you may use them. 

 

IS NOT EQUAL TO = Everyone except Administration 

IS BETWEEN   = Between 2 dates or values (i.e. Pay) 

IS NOT BETWEEN = Outside of 2 dates or values (i.e Show people who earn under £10000 and over 

£20000 

GREATER THAN   = Greater than a date or value 

LESS THAN   = Less than a date or value 

CONTAINS  = Use % as a wildcard to show all the Managers by entering % Manager in the Job 

Title Field 

DOES NOT CONTAIN  = As above but showing everyone except the Managers for example. 

 

  

1.3.4 .Layout Page Overview 

Once you have changed the criteria of the data within your report, you will need to change the appearance of the 

report so that it is suitable for printing. This is all done within the Layout Page tab.  

 

The layout page consists of a toolbar and the main layout of the report where changes can be made to alter the 

appearance of the report. 
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This page is split into sections (these will depend on what was selected during the set up stage in the Report 

wizard). Each section is divided by a blue line and these can be moved up and down the page by clicking and 

dragging them. 

 

 

 

 

Down the left of the screen are abbreviations for each section: 

 

Abv Description Explanation 

RH Report Header Items in this section only appear at the very top of the report 

PH Page Header Items in this section appear at the top of every page (Except page 1) 

D1 Detail This is where the bulk of the information is displayed 

RF Report Footer Items in this section only appear at the very bottom of the report – ideal for grand totals 

PF Page Footer Items in this section appear at the bottom of every page (Except page 1) 

 

The following sections may also appear on some reports: 

 

Abv Description Explanation 

GH Group Header Used in reports which are grouped by a field in the database (such as Department) 

GF Group Footer As above, but used to show totals by a field (again, Headcount by department) 

 

 

When creating a new report you will always need to change the height of the DETAIL section as this defaults to a 

much bigger size than is usually required. Simply click on the blue line above the D1 section and drag upwards 

until it stops, then let go. Click on Preview Report to see the difference. 

 

You will also see in the Layout Page tab that within the sections are a number of boxes, called objects. These 

objects are basically the chosen fields (displayed with a bracket around it for example, [FIELD]) and labels which 

are used as headers to show which field is which on the report. 

 

You may find that some objects are not sized correctly and therefore in the Preview Report tab names etc maybe 

cut off. 

 

To resize and object simply click on it and 8 black dots called ‘sizing handles’ will appear. Click and drag on the 

relevant sizing handle to resize the object. 

 

To move an object, simply click in the centre of the object and drag it into position. 

1.4 Using the Page designer 

The Page Designer is a tool whereby we can Add sections (using the Arrange Tab), Place additional objects onto 

the report (using the PLACE tab) or changing the properties of an object (using the Customise tab). 

 

To activate the Page Designer, click on the 'blue triangle on a page' icon from the toolbar (ensuring you are in the 

Layout Page view) and immediately click and drag the Page Designer box to the right of your screen (this will save 

hassle later). 

 

1.4.1 Sections – Arranging 

From the Arrange tab it is possible to add and remove sections within the report although it is recommended that 

these are set up within the wizard as it is much easier. 
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You may however use this tool to add or remove footers to the report especially a report Footer if you wish to add 

a grand total to the report at a later stage. To do this 

 

1. Open the Page Designer 

2. Click on the Arrange Tab 

3. Click on the Report Header section and a button will appear 

4. Click on the button 

5. Click on the “Header has a footer” option 

6. Click OK 

7. Close the Page designer 

 

1.4.2  Placing Objects 

You may wish to add a field (or other object such as a line) to the report, or you may want to add a calculated field 

to the report to show a grand total for example. 

 

If you wish to add a field to the report, you need to ensure that this has been added in the Define Search tab first. 

To add a field, open the page designer, click and drag the field you want to add into position on the page. 

 

If the Automatically caption field option is ticked, then a label showing the field name will appear automatically for 

the field you have added. 

 

To add a grand total for your report in this case add a total headcount: 

 

1. Click on the Define Search Tab  

2. From the Master Details Section in the top half of the screen, drag the "StaffNo" field into the bottom half 

of the screen where the other fields used in the report are present.  

3. Click on the Layout Page Tab  

4. Open the Page designer (the 'blue triangle on a page' icon from the toolbar)  

5. Click on the PLACE Tab  

6. Click on COUNT  

7. Click on the StaffNo Field  

8. Click on the Layout Page to add the calculated field to the report, then drag this into position into the 

Report Footer Section.  

9. Click on the Preview Tab to see the results. 

 

NOTE: You may need to add the Report Footer section to the report first 

 

More ‘complicated’ calculations will be described in the examples at the end of the reports section of this manual. 

 

1.4.3 Customising Objects (Labels) 

You may want to change the content of a label for example the title of the report. To do this simply select the 

object (not a database field object (one with brackets)) by clicking on it, then right click and choose EDIT CAPTION 

from the list of options. Alter the content of the label and close the Page Designer to view the changes. 
 

In some reports which show pay information you may want to add a symbol such as a pound sign. To do this: 
 

1. Click on the Layout Page Tab  

2. Open the Page designer (the 'blue triangle on a page' icon from the toolbar)  

3. Click on the Label button ("L" icon) in the PLACE tab  

4. Click on the Page layout, where you want the label to appear.  

5. Click on Properties tab on the Page Designer  
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6. Click on the "Caption" tab at the bottom of the PAGE DESIGNER and type the text you want to appear in 

the label (for example "£")  

7. Move the label into position on the report  

8. Click on the Preview tab to see the results. 

 

1.5 Previewing the report 

To preview how the report will look when it is printed, click on the Preview Report Tab. 

1.5.1 Printing 

To print a report, simply click the PRINT button on the toolbar. 

 

If you wish to change the Print Setup, click the REPORT SETUP Button on the toolbar (The icon shows a page 

with a yellow ruler through it). 

From here you will typically only change the paper size, and the orientation (Portrait or landscape). 

 

1.52 Exporting Reports 

You may wish to export the data from a Personnel Manager report into another application such as MS Excel. You 

may find however that this is best done by setting up a query rather than a report as some aspects of the report 

will not be transferred across to the spreadsheet (such as groupings). 

 

1. Whilst in Preview Report View, choose EXPORT from the file menu. This should open an EXPORT TO FILE 

dialogue box.  

2. Use the browse button to choose where you would like the file to be saved.  

3. Choose ASCII Delimited File (*.TXT) from the File Type field and click OK.  

4. This will save the data into a text file which can be viewed in the Windows notepad and which can either be 

imported into Excel or can be imported into another Database.  

 

NOTE: This is exactly the same process as with exporting Queries (Please refer to Personnel Basic Training 

Manual, for further information). 

 

 
HOT TIPS FOR REPORT WRITING:  

 

� If grouping by Individual, you will always use the Employee Number field and group by it. 

� If you wish to filter by a field, which you don’t want to see in the report, then you can add this manually 

later. 

� Don’t forget, to only view an existing report, simply double click on it, however if you want to edit this report 

you must click on it and then press edit on the tool bar. 

� Don’t forget to Preview your report after making each change where possible, this will ensure that if you 

make a mistake, you spot it early. 

� If you place an object so that it crosses a section (a blue line) then it is likely that the object will not appear 

on the Preview Report view. 

 

1.6 Editing Reports 

1. Click on the Report button on the toolbar 

2. Select the Query you wish to edit and press EDIT 

3. Click on the Define Search Tab  

4. Select the field you wish to edit by finding FIELD on the left column (GREY) and follow this row across until 

you find the relevant field.  

5. Double click on the chosen field (i.e. Department.) to open the field settings box.  
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6. Choose the IS EQUAL TO filter  

7. Type the value you wish to filter on (i.e. Administration) in the first filter box. Please note that you must type in 

the value, exactly as it appears in the database.  

8. Click OK  

9. Click on the Preview Report Tab  

  

1.7 Deleting a Report 

1. Click the Reports button on the Tools toolbar. 

2. Select the report you want to delete and click the Delete button. 

3. Click YES to confirm 

 

NOTE: Once you have deleted a report it cannot be retrieved. 

 

 

1.8 Report Examples 

As previously discussed there are 3 main types of reports, Detailed List, Grouped and Summary.  

 

All of these reports will be explained in the following examples, along with other useful ideas of how you can get 

the most from reports. All these examples use the demonstration database, but may also work with your own data. 

 

All of these reports will be initially set up using the wizard and is the same in each case apart from which Tables 

and fields are used. 

 

1.8.1 Example Report #1 – Employee phone list 

This report is a simple phone list  

 

Choose the fields using the wizard 

 

1. Click on the Reports button 

2. Click on the folder within the report explorer, where you want the report to be saved (i.e. Reports folder) 

3. Click the NEW button on the toolbar 

4. Choose REPORT and enter a name for the report in the box provided 

5. Next 

6. Find Employee Details from the left hand window and double click to select it, then click Next 

7. Choose the following fields EmployeeDetails.Department, EmployeeDetails.Surname, 

EmployeeDetails.Firstname, EmployeeDetails.Work Telephone, then click Next 

8. Click Next 6 times 

9. Finish 

10. A new window will open showing the Layout Page view. Click Maximise 

 

 

Setting the sort order 

 

1. Click on the Define Search tab 

2. Open the properties for Department and set SORT to A-Z and click OK 

3. Repeat for Surname and Firstname 
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Setting up the layout and objects to make sure everything is displayed properly on the report preview 

 

1. Click on Layout Page tab 

2. Reduce the height of the Detail Section 

3. Select the Work Telephone field and label by Shift clicking them both and drag them to the right 

4. Repeat with the Firstname field 

5. Stretch the width of Surname field and then the firstname field 

6. Preview the report 

 

The report is now ready for printing
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1.8.2 Example Report #2 – Employee phone list grouped by department  

 

In this example we are using Postname instead of Surname and Firstname 

 
START OFF USING THE WIZARD TO SET UP THE REPORT 

 

1. Click on the Reports button 

2. Click on the folder within the report explorer, where you want the report to be saved (i.e. Reports folder) 

3. Click the NEW button on the toolbar 

4. Choose REPORT and enter a name for the report in the box provided 

5. Next 

6. Find Employee Details from the left hand window and double click to select it and then click Next 

7. Choose the following fields EmployeeDetails.Department, EmployeeDetails.Postname and  

EmployeeDetails.WorkTelephone, then click Next 

8. Click Next 3 times until you get to the Groups screen of the report wizard 

9. In the Available Fields window double click on EmployeeDetails.Department so that it appears in the 

Groups window. 

10. Click Next 3 times 

11. Finish 

12. A new window will open showing the Layout Page view. Click Maximise 

 
THE NEXT STEP IS TO SORT OUT THE SECTIONS AND THE LAYOUT: 
 

1. Reduce the height of the Detail 1 Section 

2. Move the Work Telephone field and Label to the right (Shift click on both objects) 

3. Increase the width of the Postname field 

4. Increase the height of the Group Footer:Department 

5. Click on the Preview tab to see the results. 

 

 
WE NOW WANT TO SORT THE REPORT BY DEPARTMENT THEN SURNAME, SO WE NEED TO ADD THE 
SURNAME FIELD TO THE DEFINE SEARCH PROPERTIES: 

 

1. Click on the Define Search Tab  

2. Click on the Surname field from the Master Details table  

3. Drag this field down in to the bottom half of the screen to add it to the other fields you have chosen in 

your report (double clicking on the chosen field also works)  

 
CHANGING THE SORT ORDER 

 

1. Click on the Define Search tab 

2. Open the properties for Department and set SORT to A-Z and click OK 

3. Repeat the process for Surname ensuring that Department is before Surname in the Field grid.  
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1.8.3 Example Report #3 – Headcount by Department Summary 

 

Choose the fields using the wizard 

 

1. Click on the Reports button 

2. Click on the folder within the report explorer, where you want the report to be saved (i.e. Reports folder) 

3. Click the NEW button on the toolbar 

4. Choose REPORT and enter a name for the report in the box provided 

5. Next 

6. Find Employee Details from the left hand window and double click to select it, then click Next 

7. Select the EmployeeDetails.Department and EmployeeDetails.Employee Number fields, then click Next 

8. Click Next 6 times 

9. Finish 

10. A new window will open showing the Layout Page view. Click Maximise 

 

Setting up the layout and objects to make sure everything is displayed properly on the report preview 

 

1. Click on Layout Page tab 

2. Reduce the height of the Detail Section 

3. Select Employee Number field and label by Shift clicking them both and drag them to the right 

4. Stretch the width of the Department field 

5. Preview the report – it should show a list of departments and employee numbers which is quite 

meaningless. 

 

 

Setting up the Headcount Calculation 

 

1. Click on the Define Search Tab 

2. Open the properties for the Department Field 

3. Change the SHOW property from SHOW to GROUP and click OK 

4. Open the properties for the StaffNo field 

5. Change the SHOW properties from SHOW to COUNT 

6. Preview the report to see the changes 

 

 

To tidy up the report you may want to change the Employee Number label to Headcount by Department by: 

 

1. Click on Layout Page tab 

2. Click on Employee Number label 

3. Right click and choose Edit Caption 

4. Change the text to Headcount by Department and close the Page Designer 

5. Preview the report to see the changes 
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1.8.4 Example Report #4 - Salaries by Department 

 
START OFF USING THE WIZARD TO SET UP THE REPORT 

 

13. Click on the Reports button 

14. Click on the folder within the report explorer, where you want the report to be saved (i.e. Reports folder) 

15. Click the NEW button on the toolbar 

16. Choose REPORT and enter a name for the report in the box provided 

17. Next 

18. Find Employee Details from the left hand window and double click to select it, then Current Pay Details 

and then click Next 

19. Choose the following fields EmployeeDetails.Department, EmployeeDetails.Postname, 

CurrentPayDetails.AnnualPay, then click Next 

20. Click Next 3 times until you get to the Groups screen of the report wizard 

21. In the Available Fields window double click on EmployeeDetails.Department so that it appears in the 

Groups window. 

22. Click Next 3 times 

23. Finish 

24. A new window will open showing the Layout Page view. Click Maximise 

 
THE NEXT STEP IS TO SORT OUT THE SECTIONS AND THE LAYOUT: 
 

6. Reduce the height of the Detail 1 Section 

7. Move the Annual Pay field and Label to the right (Shift click on both objects) 

8. Increase the width of the Postname field 

9. Increase the height of the Group Footer:Department 

10. Click on the Preview tab to see the results. 

 
ADDING A LABEL TO THE REPORT (FOR EXAMPLE, ADDING A "£" SYMBOL) 
 

1. In the Layout Page view, open the Page designer (the 'blue triangle on a page' icon from the toolbar)  

2. Click on the Label button ("L" icon) in the PLACE tab  

3. Click on the Page layout, where you want the label to appear.  

4. Click on Properties tab on the Page Designer  

5. Click on the "Caption" tab at the bottom of the PAGE DESIGNER and type the text you want to appear in 

the label (for example "£")  

6. Move the label into position on the report  

7. Click on the Preview tab to see the results. 

 
THEN ADD A REPORT FOOTER SECTION TO THE REPORT SO WE CAN ADD A GRAND TOTAL. 

 

1. In the Layout Page view, open the Page designer (the 'blue triangle on a page' icon from the toolbar)  

2. Click on the ARRANGE tab  

3. Click on the ADD button (at the bottom of the page designer)  

4. Click on REPORT HEADER (Ensure that the FOOTER is ticked at the bottom)  

5. Click OK  

6. Reduce the height of the Report Header Section 
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WE NOW WANT TO SORT THE REPORT BY DEPARTMENT THEN SURNAME, SO WE NEED TO ADD THE 
SURNAME FIELD TO THE DEFINE SEARCH PROPERTIES: 

 

4. Click on the Define Search Tab  

5. Click on the Surname field from the Master Details table  

6. Drag this field down in to the bottom half of the screen to add it to the other fields you have chosen in 

your report (double clicking on the chosen field also works)  

 
CHANGING THE SORT ORDER 

 

4. Click on the Define Search tab 

5. Open the properties for Department and set SORT to A-Z and click OK 

6. Repeat the process for Surname ensuring that Department is before Surname in the Field grid.  

 
TO ADD A CALCULATED FIELD SUCH AS A HEADCOUNT WE MUST FIRST ADD THE STAFFNO FIELD AS 
IT WAS NOT ORIGINALLY SELECTED DURING THE WIZARD AS WE DID NOT WANT IT TO APPEAR ON 
THE REPORT. WE THEN NEED TO ADD THIS FIELD TO THE REPORT WHILST APPLYING A COUNT 
CALCULATION: 

 

1. Click on the Define Search Tab  

2. From the Master Details Section in the top half of the screen, drag the "StaffNo" field into the bottom half 

of the screen where the other fields used in the report are present.  

3. Click on the Layout Page Tab  

4. Open the Page designer (the 'blue triangle on a page' icon from the toolbar)  

5. Click on the PLACE Tab  

6. Choose COUNT  from the Calculated Field drop down 

7. Click on the StaffNo Field and drag it into position into the Group Footer:Department Section.  

8. Click on the Preview Tab to see the results.  

 

Repeat steps 3 to 8 using the Annual Pay field instead of StaffNo to give total salaries by Dept 

  

If you wish to show a Grand total, then simply repeat this process but drag the fields into the Report Footer section  

 

 
FILTERING THE REPORT 

This example will use a filter to show just the Administration Department and can be used in the report without 

actually viewing Department in the final report. 

 

1. Click on the Define Search Tab  

2. Select the field you wish to edit by finding FIELD on the left column (GREY) and follow this row across 

until you find the relevant field. 

3. Double click on the chosen field (i.e. Department.) to open the field settings box.  

4. Choose the IS EQUAL TO filter  

5. Type the value you wish to filter on (i.e. Administration) in the first filter box. Please note that you must 

type in the value, exactly as it appears in the database.  

6. Click OK  

7. Click on the Preview Report Tab  
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2. Security Manager 

2.1 General Overview 

The Security Module allows you to set up comprehensive security profiles to determine which users can see which 

aspects of the system. 

 

The security works on 5 levels: 

• Database – Determines which Databases the user can access 

• Screen – Determines which screens the user can access 

• Field – Determines which fields the user can access 

• Functions – Determines which Functions the user can perform 

• Employees – Determines which employees the user can see 

 

To open the Security Module: 

1. Close Personnel Manager 

2. Open the Security Module by clicking START>PROGRAMS>VIZUAL BUSINESS TOOLS>PERSONNEL 

MANAGER>SECURITY MANAGER. 

2.2 Creating/Editing Users and Templates 

Before creating a new security profile it is essential that thought is given to what exactly it is the user can do and 

see. 

 

To create a new user (From with the Security Manager Module): 

  

1. Click New User button on the toolbar down the left of the screen, or choose New User from the FILE 

menu 

2. Choose the “I want to specify all settings myself” and click NEXT 

3. Enter a Username (this is the name the user will use to log in) 

4. If the Users record is already stored on Personnel Manager click theStaff Number picklist to find the 

employee. This will then automatically complete some of the details for you. 

5. Enter the full name of the user 

6. Enter a password for the user 

7. Enter the same password in the confirm box and click NEXT 

8. Enter in the details on this screen if required (Not essential) and Click Next 

9. Click NEXT 

10. Click Finish 

 

This will create a new user who will by default have full access to Personnel Manager. 

 

You will now need to remove access privileges where required as explained in the following sections: 

2.3 Setting up Security Restrictions 

There are 3 ways of opening the Security settings wizards, either right click on the user, from the Security drop 

down menu or from the Security shortcut bar on the left of the screen. 

2.3.1 Database Security 

1. Click on the user you want to change 

2. Right click and choose Databases 

3. Double Click on the Databases you DO NOT want this user to see and click NEXT 

4. Click FINISH 
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3.2.2 Screen Security 

1. Click on the user you want to change 

2. Right click and choose Screens 

3. Click NEXT 

4. Double Click on the screens you DO NOT want the user to see and click NEXT 

5. Double Click on the screens which you want the user to see BUT NOT Edit, click Next 

6. Double Click on the screens which you DO NOT want the user to be able to Delete, click Next 

7. Click Finish 

2.3.3 Field Security 

You will need to repeat this process for each screen where there is a field with restricted security 

 

1. Click on the user you want to change 

2. Right click and choose Fields 

3. Click NEXT 

4. Choose the Screen which contains the field(s) you wish to change the access rights to , click Next 

5. Double Click on the fields which you DO NOT want the user to have access to 

6. Double Click on the fields which you want the user to see BUT NOT Edit, click Next 

7. Click Finish 

2.3.4 Function Security 

Function Security is where you restrict the user from performing certain functions such as Archive an employee etc 

TIP: If you are unsure if the user will need access to a particular function then prohibit it anyway – it can 

always be added back later and it often proves to be better safe than sorry! 

 

1. Click on the user you want to change 

2. Right click and choose Functions 

3. Click NEXT 

4. Double click the functions in the Functions Allowed window to move them into the Functions Prohibited 

Window, therefore preventing the user from performing the chosen functions. 

5. Click Next 

6. Click Finish 

2.3.5 Employee Security 

Employee security allows you to restrict access to an employees or a selection of employees. 

 

NOTE: It is important to remember that this feature is one dimensional – you cannot prevent the user seeing pay 

for one group of employees yet giving them access to another group within the same profile. To do this you will 

need to set up 2 separate profiles. 

 

1. Click on the user you want to change 

2. Right click and choose Employees 

3. Click NEXT 

4. Press ADD. 

5. Choose the field you wish to use as a filter (if it is just one employee to do not want the user to see, use 

their employee number for example), Click OK 

6. Click Next 

7. Click Finish 

2.4 Security Audit 

The Security Audit allows you to track who has made what changes to which records within Personnel Manager. 
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To open the Audit utility, whilst in The Security Module, choose VIEW AUDIT TRAIL from the SECURITY drop 

down menu. 

 

From here you can Apply a filter to find specific information such as who made a change or what changes were 

made on a specific date etc. 

 

If you wish to disable the Audit Trail choose AUDIT TRAIL DISABLED from the OPTIONS drop down menu. 



 

 

 

 

Page 19 of 35         05/07/2011 

 

Property of Agathon Consulting 2011 

 

 

3. Utilities 

3.1 Batch Inputs 

A Batch input is a tool which can be used in conjunction with a group or a filter to create new records for more than 

one employee simultaneously. A good example of this would be when you have a group of employees who have 

attended the same Training Course, or if you would like to create a Holiday for all your employees over the 

Christmas period, known as Company Shutdown. 

 

NOTES: You will need to create your group or filter before starting the Batch Input. 

You may also wish to back up your database before starting the Batch Input in case you make a 

mistake. 

To create a Batch Input 

1. Choose BATCH INPUT from the TOOLS drop down menu. 

2. Click NEXT on the first screen. 

3. Choose the Sub-Screen you wish to add a record to (E.G. Training History), Click NEXT 

4. Choose the fields you would like to add data into, Click NEXT 

5. Choose Group, Filter or Manually Select Employees to determine who will be given this new record, Click 

NEXT. 

6. Enter the data for the first employee in the list. 

7. Then click on the Duplicate Values button on the toolbar, ensuring that the employee where you have typed in 

the data is still selected.  

8. Click YES. These 'values' will then be pasted into all of the selected employees to save you from having to 

type them all in again. 

9. Once complete press the Save Icon (Perform Batch Input button) and Click YES 

10. Click OK 

11. Click FINISH 

 

Please remember Batch Inputs are not reversible. Take care when typing in the Values (data) in the Batch Input to 

avoid any spelling mistakes etc, otherwise you will either have to restore the backup you made previously or you 

will need to go through each employee where a new record was created and manually amend the mistake. 

 

3.3 Global Updates 

Global Update is an excellent tool which works in similar way to Batch Inputs. Where it works best is where say the 

name of one of your company departments has changed and you wish to update the database without having to 

manually change each individuals record. This is explained in the following example where we would like to 

change the “Sales & Marketing” Department to “Sales”  

 

1. Within Personnel Manager, choose GLOBAL UPDATE from the TOOLS drop down menu 

2. Click OK (It is worth noting that if you do not do a backup the changes you make cannot easily be 

recovered if it goes wrong). 

3. Click NEXT 

4. We wish to select from All Employees (although a Filter/Group could be used, if it had already been 

setup), Click NEXT. 

5. Choose the screen you wish to update, in the case Employee Details, Click Next 

6. We are updating Existing records so click Next 

7. We want to select from all records, so click Next 

8. Here we make our selection of which records will be updated (In this case it will only update the 

employees with “Sales & Marketing” in their Department field), Press ADD 

9. Choose the Department field from the drop down and click OK 
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10. Here we simply want to select the department we wish to change in this case Sales & Marketing. If the 

value is not in the drop down, simply type it into the empty box 

11. Click ADD and Click OK 

12. Click Next 

13. Here we enter what the new value will be for the chosen field, Click ADD 

14. Choose DEPARTMENT as the Field 

15. SET TO will be selected as the operator by default 

16. Enter the new Value, in this case “Sales” into the Value box 

17. Click OK 

18. Click Next  

19. At this point you can still cancel the update if you are unsure. Otherwise click Next again to perform the 

Global Update. 

20. It may take a few seconds for it to perform the update depending on the number of records to be 

updated. Once complete press Finish to exit the wizard. 

 

Again, take care when performing Global Updates, as mistakes are very difficult to rectify. Ensure you are clear on 

what you are doing before you run the update. 

 

  

3.4 Purging Data 

It is possible to Purge large quantities of data from Personnel Manager by using the Purge Tool. 

 

An example where you may use this tool is say if you had 5 years worth of Holiday and Absence records and you 

no longer need more than 2 years history. What you can do in this case is purge all of the Holiday and Absence 

records prior to a particular date. 

 

Great care is needed when using this tool as records cannot be recovered once they have been purged. 

 

To purges records: 

 

1. Select PURGE from the FILE menu 

2. Select which screen contains the Data that you wish to Purge, in this Holiday and Absence.  

3. Choose the Date field, which is to be used to determine which data, is to be purged. (For example, you 

could Purge all Holiday and Absence records where the Start Date is before 01/01/1999.) 

4. Enter the “Purge all data before” date 

5. Click CONTINUE to purge the data (or Cancel to exit the wizard without purging anything). 

6. Click YES to continue 

7. Click OK 

8. Click CANCEL to close the wizard. 

 

 
It may be worth backing up your database before performing a Purge. Once data has been purged it 
cannot be retrieved! 



 

 

 

 

Page 21 of 35         05/07/2011 

 

Property of Agathon Consulting 2011 

3.5 Importing Data 

You maybe required to import data into Personnel Manager whether it be from another system to create a 

database from scratch or to update key fields via import rather than manually editing the employees record. 

 
NOTE: Importing of data using the Personnel Manager Database Maintenance Module, requires exclusive 
access to the system, therefore all other users will need to log out of Personnel Manager for the duration 
of the process. 

3.5.1 The Import Options 

There are a number of options for importing data which will greatly effect what how the data is imported. Refer to 

the following option guide to ensure you select the correct option. (It is recommended that you perform a backup 

before importing any data) 

Importing Employee Details 

 

Option 
 

Description 

Ignore Duplicates This will only import records where the employee number does not 

already exist in the database 

Ask on Duplicates then replace imported fields only This option will warn you that a duplicate employee number has been 

detected. If you choose to proceed with the import, only fields which 

are different to the existing record will be imported in addition to 

creating new records for any new employee numbers detected 

Ask on Duplicates then import all fields This option will warn you that a duplicate employee number has been 

detected. If you choose to proceed with the import, all the fields for 

this employee will be imported, overwriting the existing data, in 

addition to creating new records for any new employee numbers 

detected 

Replace Duplicates - imported fields only This option automatically imports any fields which differ in the 

database. For example, where a new employee number appears a 

new record will be created, If an employees address details differ 

within the import file to that on the database, these fields will be 

overwritten. 

Replace Duplicates - all fields This option automatically overwrites all existing data where a 

matching employee number is found. As above it will also add a new 

record for any new employee numbers. It will not however, delete any 

existing records on the database if they do not exist within the import 

file. 

 

It is essential that employee numbers remain constant when regularly importing data into Personnel Manager (for 

example, when updating records from another system) 

 

Importing other information, such as Training History (Sub-records) 

You basically have two options for importing data into a sub-record 

 

Option 
 

Description 

Append imported records to existing  Here, imported records will be added to the existing employee sub-

records 

Replace existing records with  imported records Existing record for an employee are deleted before importing the new 

data. 
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3.5.2 Setting up an import template/definition 

 

Use the following procedure to set up a new Import wizard template/definition.  

 

1. Open the Personnel Manager Database Maintenance module. 

2. Open the database you wish to import into 

3. Click the IMPORT DATA button on the toolbar.  

4. Select "I want to create and use a new import definition".  

5. Choose file "filename.csv" by using BROWSE button.  

6. Select "First row contains headings".  

7. Ensure the date format is set to dd/mm/yyyy 

8. Select the table which you want the data to be imported into using the "Import into table" field.  

9. Click NEXT  

10. Choose an import option (highlighted above) 

11. In the Personnel Field column, map the fields in the data file to the fields in the table.  

12. Select "I want to save these details as a template then import data now".  

13. Type in a name for the template 

14. Click Finish  

15. Your data should now be imported into the database, click OK when complete. 

 

Re-using an Import definition/template 

 

Once you have set up a Import Template it can be re-used to re-import data again and again as explained below: 

 

Open the Personnel Manager Database Maintenance module. 

Open the database you wish to import into 

Click the IMPORT DATA button on the toolbar.  

Select "I want to use/edit an existing import definition" 

Choose the Import definition (Template) you wish to use and click NEXT 

Ensure that you select the correct file which is to be used to import using the browse button 

Click NEXT 

Click NEXT 

Click NEXT 

Click FINISH 

Your data should now be imported into the database, click OK when complete. 
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4. Database Maintenance 
The Database Maintenance module is where we can backup and restore the Personnel Manager database as well 

as perform other vital maintenance on the system. 

 

4.1 Overview (Encrypt, Repair, Pack) 

4.1.1 Database Encryption 

If you are concerned about a breach of network security, you can encrypt the data to prevent the data from being 

viewed in text editor such as notepad. Please note however that encrypted databases can cause a decrease in  

performance particularly over a network. 

 

To Encrypt your databases 

 

1. Open the Database Maintenance Module 

2. Choose the Encrypt Databases option, click Next 

3. Choose the Database Encryption option, click Next 

4. Press Next to finish 

 

To Decrypt the databases follow the above process but use the Decrypt Databases option instead. 

 

4.1.2 Verify a Database 

Verifying a database, checks the chosen database for any errors. If any are discovered it will then proceed to fix 

the errors. 

 

To verify a database simply choose the Verify Database option, and click next. Choose the database to be verified 

and click Next. Click Finish when Complete. 

 

Note: It would be beneficial to back up the databases before you run this utility. 

 

 

4.1.3 Pack  Database Tables 

Packing database tables basically tidies the data within the database tables and compresses them. This results in 

Personnel Manager running faster than before. 

 

To pack database tables simply choose the Pack Database Tables option, and click next. Choose the database to 

be verified and click Next. Click Finish when Complete. 

 

Note: It would be beneficial to back up the databases before you run this utility. 

 

 

 

4.2 Backing up Personnel Manager 

Backups are essential to ensure that no data is lost if there are problems with Personnel Manager or before you 

run any utility which may have a great impact on your records if it goes wrong such as a global update. 
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To back up Personnel Manager: 

 

1. Open Database Maintenance Module, choose Backup Databases Option and click NEXT 

2. Select the databases you wish to backup (the more chosen the longer it will take) 

3. Click Next 

4. Choose the location where the databases are to be backed up (either onto Floppy discs or onto a 

location on your PC or Network), Click Next 

5. Click Start to run the back up. 

6. The utility first verifies the data and warns you if any errors were found before continuing with the 

backup. If errors are found run the Verify Database option as explained above. 

7. Click Close when complete and Cancel to close the Database Maintenance module. 

 

NOTE: It is often worth backing up the System Data every time you do a backup. 

 

4.3 Restoring Personnel Manager 

To restore a damaged database: 

 

1. Open Database Maintenance Module choose Restore Databases Option and click NEXT 

2. Choose the location where the backed up databases are being stored (either onto Floppy discs or onto a 

location on your PC or Network), Click Next 

3. Select the databases you wish to restore, click Next 

4. Choose the location where you want to restore the databases. You can either choose to restore the 

same location overwriting the damaged ones or to a new location. Click Next 

5. Click Start to run the back up. 

6. Click Close when complete and Cancel to close the Database Maintenance module. 

 

 

4.4 Deleting Databases 

To delete a database: 

 

1. Open Database Maintenance Module, choose Delete Database Option and click NEXT 

2. Select the database you wish to delete and click Start 

3. Click YES to confirm 

4. The chosen database will then be deleted. Click OK when complete 
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5. Screen Designer 

5.1 General Overview 

The screen designer allows you to customise existing screens or create new ones.  You can also use the Screen 

Designer to edit the Employee Record Card and other Personnel Manager screen prints and create customised 

help for your Personnel Manager users. 

 
The screen designer is very simple to use yet is quite a powerful tool, therefore great care is 
recommended before designing new fields or more importantly editing existing screens. 

 

To open the Screen designer module: 

 

1. Close Personnel Manager 

2. Open the Security Module by clicking START>PROGRAMS>VIZUAL BUSINESS TOOLS>PERSONNEL 

MANAGER>SCREEN DESIGNER. 

3. Enter your username and password 

 

 

Note: You can log in to the Screen Designer module only when no other users are logged in to Personnel 

Manager, Diary, Diary Monitor, Database Maintenance, or Security Manager. 

5.2 Making Changes to an existing Personnel Manager Screen 

For this example we will make changes to the benefits screen by adding a notes field to enable you to record more 

information about your employees’ benefits. 

 

In the screen designer: 

 

1. Open the Benefits screen by clicking the OPEN button on the toolbar and double clicking on BENEFITS. 

On opening two additional screens, Screen Properties and Field Chooser will also open. 

2. Click the NEW button on the FIELD CHOOSER to open a Field properties box. 

3. In the Field Name box, type Notes. 

4. Select Notes from the Type drop-down list. 

5. In the Display Label box, type Notes.  

6. In the Description box, type Notes relating to employee benefit. 

7. To save the new field, click OK. 

 

The field you just added will now appear in the Field Chooser screen. 

 

To add this field to the Benefits screen, simply click on the new field in the field chooser and drag it into position on 

the Benefits Screen. 

 

You may want to provide instructions on when and how to  use it for your users. To do this, you create a screen 

note.  Screen Notes are a handy way to provide additional help for your users. 

 

1. Click the Screen Properties button. 

2. Click the Screen Notes Pick list 

3. Replace the text on the screen with Use the Notes field to provide additional information about the 
employee’s benefits.  

4. Click the Save button on the Screen Notes to save the changes. 

 

To save your changed Benefits screen, click the Save button on the File toolbar. 

 

To Exit Screen Designer, select Exit from the File menu. 
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5.3 Creating new screens 

Prior to jumping in and designing your screen directly within the Screen Designer, it is important to have a clear 

idea of what you want to achieve before starting it. 

 

The following example is a new screen to track the equipment people borrow from a company and the table shown 

in the following section shows how a screen can be planned out prior to designing it. 

 

First we need to create a new screen (remember before opening Screen Designer, that all other users must be 

logged out of any Personnel Manager module): 

 

1. Click the NEW button on the Screen Designer toolbar 

2. Enter a Screen Name (Loan Equipment) and a description 

3. Click OK 

5.3.1 Creating new fields 

There are several properties which can be defined for new fields. These are split into the following sections: 

 

Field Where we set up the basic field properties such as name etc. NOTE: Some of these properties cannot be changed 

once setup. 

 
Field Name: 

Type the name of the field. The name can contain the letters A to Z (upper or lower case) and numerals 1 to 9, but 

can have no spaces. 

 
Type:  

Select the type of the field. It can be: Date, Decimal Number, Integer Number, Logical, Notes, Text, or Time. 

 
Size:  

If this is a Text field, type the maximum number of characters that users can enter. 

 
Display Label: 

Type the label to be displayed on the screen. 

 
Description: 

Type a description of the field. 

 

Sorting Determines whether or not this field can be used to sort by within Personnel Manager 

Tip: Use this checkbox only when necessary. The more sort fields you have, the slower updating records becomes. 

 

Display To set the Display format - Depending on the type of field selected, the options vary. For example, if you selected a 

text field, you can choose Normal, Uppercase, Lowercase, or Mixed Case format; if you selected a date field, you can 

choose Long, Medium, Short, or windows default date formats. 

 

Value To set up calculated fields 
 

Use the Build Expression screen to specify the formula for the calculation. 

 

The result is updated when the user enters data in the fields used as the basis for the calculation and appears when 

the user displays the screen. 
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To create the calculation, double-click the desired folders to display and select the Fields, Functions, Operations, and 

Common Expressions you want. 

 

Following are some examples of field calculations used in current Personnel Manager screens. 

 

• To calculate the number of days between the date the employee joined the pension plan and today, determine the 

number of days between the date when the employee joined and the current date. 

 (Employee Details - LengthofService). 

DATEDIFF([PensionSchemeJoin],Today()) 

 

• To calculate the total cost of an absence, add the cost of the absence, the  

  percentage of on-costs, plus the additional costs. 

 (Holiday and Absence - TotalCost) 

  [Cost] + ( ( [OnCost] / 100) * [Cost] ) + [AdditionalCost] 

 

• To extract the year from the a date. 

 (Holiday and Absence - FromYear) 

  YEAR([StartDate]) 

 

• To calculate the difference between planned and actual structural training points. 

  (CPE/CPD Record - UnstructuredVariance) 

   [UnstructuredActual] - [UnstructuredTarget] 

 

• To calculate double time. 

  (Pay History - DoubleTime) 

  [HourlyRate] * 2 

 

 

Validation To set up a validation formula for the field to force users to enter data correctly in this field 
A Value Is Required For This Field: 

Click this checkbox if the field is mandatory. 

 
Validate This Field Before Saving: 

Click this checkbox if the field must be verified before the record is saved. 

 
Entering Field Validation Formulae 

Use the Field Validation screen to enter a rule for the field. This rule is to be performed each time data the user enters 

data in this field. If the data does not conform, the user receives an error message. 

 

The validation rule must produce a true or false result; for example: 

 

TotalCost > 1000 will produce a true/false result, whereas TotalCost * 1000 

will not. 

 

To create the rule: 

 

1.   Double-click the desired field from the Field list. 

2.   Double-click the desired function from the Functions list. 

3.   Type the value in the Validation Statement. 

4.   Check the validity of the expression by clicking the Test Expression button. 

5.   Click OK. 

 

Following are some examples of validation rules used in current Personnel Manager screens. 
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• To ensure that the end date of absence is greater than or equal to the start date. 

   EndDate >= StartDate 

 

• To ensure that the equipment VALUE is greater than 1. 

   VALUE > 1 
Display This Message If Validation Fails: 

Type the message that is to appear if the verification fails. 

 

 

Picklist Whether or not the field is a picklist and what type 
 
This Field Has A Pick List: 

Click this checkbox if this field is to be a Pick List. 

 
A Value Must Be Selected From the Pick List: 

Click this checkbox if a value must be selected from the list; if the user is to be able to add values, clear this checkbox. 

 

• To add a value, click the Add button. Type the new value and click OK. 

 

• To remove a value, select the value and click the Delete button. To confirm the  

  deletion, click OK. 

 

If the items in the Pick List are values in another field in Personnel Manager click the More button. 

 

The Pick List Options screen appears. 

 
Pick List Type: 

Select one of the following types: 

 

Standard.  

Create a standard Pick List. Users can add or remove items from this Pick List if you select the A Value Must Be 

Selected From the Pick List checkbox on the Pick List tab. 

 

Pick From Employee Data. 

Create a Pick List from Employee data; for example, Post Names. Users cannot add or remove items from this type of 

Pick List. 

 

Pick From Company Data. 

Create a Pick List from Company data; for example, Currency. Users cannot add or remove items from this type of 

Pick List. 

 

 

We are initially only concerned with the FIELD properties (more can be added later). The following table shows the 

fields we want to include on our new Loan Equipment Screen and their properties: 

 

Field Name Field Type/Size Display Label Description 

LoanOutDate 

 

Type: Date Date Date equipment was loaned out 

Returned 

 

Type: Date Returned Date equipment is to be returned  

Description Type: Text  

Size: 30 

Description Description of equipment 

EquipmentValue 

 

Type: Decimal Number Value Value of the equipment  
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To set up these fields: 

 

1. Click NEW on the Field Chooser 

2. Enter the details as per the above table (the additional properties will be added later). 

3. Click OK after each one is completed. 

 

 

We then will edit the EquipmentValue field so that it shows the value to 2 decimal places 

 

1. On the field chooser double click on the Value field (or Click to select and then press EDIT). 

2. Click the Display Tab 

3. Select 2 Decimal places from the format drop down and click OK 

 

The fields are now set up and ready to be added to the screen. (We can edit these further at a later stage.) 

 

5.3.2 Adding Objects to the screen 

 

To add an object to the screen, simply click on the field you wish to add and drag it into position on the screen. 

Repeat this process for each of the fields you wish to add. 

 

NOTE: There maybe some fields which you wish to create for use in Filters etc. Simply create the fields in the field 

choose but don’t drag them on to the screen and they will still be available for use in reports etc. 

 

These are typically calculated fields for example BirthdayMonthName on the Employee Details Screen. 

 

5.3.2 Editing Fields 

 

In this example we will edit the Description field and change it to a picklist field. 

 

1. Double click on the Description field in the field chooser to open the properties 

2. Click on the Picklist tab 

3. Click on the THIS FIELD HAS A PICKLIST option (so that it is ticked) 

4. Click OK (Values can be added either at this stage or once we are back in Personnel Manager) 

5. Click on the Description field on the Loan Equipment Screen (the box rather than the label) and press 

delete 

6. On the Controls toolbar (typically on the right hand side of the window) click on the Variable picklist 

button and drag it into position on the screen 

7. Whilst it is still selected right click and choose Control Properties 

8. From the field drop down list choose the Description field. 

9. Click OK 

 

 

This links the Pick List control with the Description field. 

 

To avoid wasted space on the form, you can reduce the size of the screen and play around with the layout of the 

screen. 

 

You may also find if fields are moved around the screen that the Tab order is incorrect within Personnel Manager. 

If this is the case Click on the ORDER button on the Screen designer toolbar and move the fields into the desired 

position using the up and down arrow buttons. 
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5.4 Deleting Screens 

To reduce the number Personnel Manager screens to those only needed for your organisation, simply remove the 

unnecessary screens from Personnel Manager.  

 

This will simplify the interface for your users. 

 

To Delete a screen: 

 

1. On the File toolbar, click the Open button or from the File menu, select Open Screen 

2. Select the screen to be deleted by clicking on it 

3. Press DELETE and click YES to confirm 

 
Important Notes: 

• Deleting a screen in the screen designer not only removes the screen, but also removes its icon from the  

  Personnel Manager Shortcut bar, fields and all data associated with it. 

• You can only delete screens you have created; you cannot delete screens delivered with Personnel Manager.  

 

 

 

 

5.5 Changing the Employee Record Card 

 

You can easily tailor the layout or content of the Record Card to better meet your organisation’s requirements 

(This is the report generated when you select Print Record Card from the File menu or click the Print button when 

viewing Employee Details in Personnel Manager.) 

 

To do this, select Modify Employee Record Card from the File menu, change the layout and the content as desired 

and when you are finished, save your changes and exit the Report Designer. 

 

 

5.6 Designing Screen Prints 

 

Screen Prints are similar to the Employee Record Card. Each sub record (Screen) has a Screen Print which can 

be customised and you can create a new Screen Print for any new Screen which you design. 

  

Note: If you do not create a screen print for screens you create, a rudimentary printout is generated. 

 

To open and existing Screen Print, simply open the screen you wish to view the screen print for whilst in the 

Screen Designer module. Then choose the Design Screen Print option from the file menu. 

 

5.6.1 About the Screen Print Window 

 

When you create a new screen print or open an existing screen print with Screen Designer, a window will appear.   

As with other Personnel Manager reports, the screen print report is divided into three sections: 

 

Header, Detail, and Footer. 
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When you create a screen print for a new screen, Screen Designer displays a blank screen print report with the 

company logo and screen name in the header and the page number in the footer.    

 

When you are modifying an existing screen print, the fields appear in the Detail section. 

 

Use the various toolbars to create layout required by adding, removing, positioning, and formatting fields 

previously defined for the screen.  

 

Build or modify the layout by placing and arranging objects using the tools on the following toolbars. 

• Standard Components 

• Data Components 

• Format 

 

5.6.2 Viewing the Toolbars 

 

Only the Standard Components, Data Components, Format, and Edit toolbars are shown when you first open a 

screen print. 

To display and use the other toolbars, follow this procedure: 

 

1. Select View from the Toolbars menu. 

2. Select or deselect the active toolbars from the drop-down menu. 

 

A checkmark means that the toolbar is active. 

 

5.6.3 Example - Modifying a screen print layout 

In this example, work through each step in modifying the existing screen print layout for the Vehicle Usage screen 

provided with Personnel Manager. 

 

You decide to move the Usage Type label and field, and add the Vehicle Usage Notes label and field to the end of 

the line: 

 

1. Open the Vehicle Usage screen. 

2. Select Design Screen Print from the File menu - The Screen Designer - Vehicle Usage Screen Print 

screen appears. 

3. To move the Usage Type label and Type field to a temporary location, click and drag the Detail 

separator bar down to increase the space in the Detail section.  

4. Then press the shift key and click both the Usage Type label and Type field and drag them down into the 

body of the Detail section. Deselect these fields by click elsewhere on the page. 

5. Press the shift key and click the Date label, Date field, Vehicle label, and Registration and drag them to 

the left until positioned to the left of Miles Travelled. Deselect these fields by click elsewhere on the page 

6. To add a Notes label, click the Label button, then click in the Header to the right of the Miles Travelled 

label to place the new label. 

7. In the Label box in the toolbar, type Notes. 

8. To add the Notes field, click the DBMemo button, then click in the Detail section on the right of the Miles 

field to place the new Notes field. Adjust the size of the field as necessary. 

9. Select Notes from the Field drop-down on the toolbar.  Because content in the Notes field is variable – 

that is in some notes the length could be one line and in another it could be several – the field properties 

must be set so that the field grows with the content. 

10. Right-click the Notes field and select Stretch from the shortcut menu. 

11. Click the Save button or select Save Report from the File menu. 

12. Preview the results by clicking the Screen Designer Preview tab. 
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Now return to Personnel Manager to check the result with real data. 

 
Note: 

When viewing the result of a screen print you modified or created while in Personnel Manager, be sure that there 

are existing records or the report will be blank. 
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Appendix 1 - Glossary of Terms 
 

 

 

DATABASE 

 

Is the equivalent to a filing cabinet, which stores your employee information. You may have more 

than one database for example, one to store leavers and one to store Current Staff. 

 

RECORD 

 

A record is similar to a file you may keep within a filing cabinet, where you have one file per 

employee. This is the same with Personnel Manager where, each employee has a record for 

storing his or her details, (for example, Employee Details Screen). Each employee's record is 

made up of sub-records such as Training History. 

 

SCREEN Is where we can clearly view the details of an employee's record. This is called the Employee 

Details screen and only records the current information about each employee. 

 

SUB-SCREEN In addition to the Employee Details screen, we have Sub-screens, where we can record other 

information such as Training History or Pay History. These are sometimes referred to as Sub-

Records or History Screens. 

 

TABLE Is where the data is actually stored within the database. Each table has a screen in order to view 

the details more clearly. You may find that there are extra fields on a table than appears on the 

screen. These are useful in Filters, Queries and Reports. 

 

FIELD Where we can add specific data about an employee. For example, the Department field is where 

we enter which department the employee works within. There are several types of fields, Text 

fields, Pick List fields etc. 

 

DATA Data is another word for Information or Details. 

 

FIXED PICK LIST 

 

Is a list of data relevant to a specific field where you cannot add extra items. For example, the 

Gender Field. 

 

PICK LIST 

 

Is a list of data relevant to a specific field where you can add your own items. For example, Job 

Title Field. NOTE: These can be set up as Fixed Pick Lists using the Screen designer. 

 

FILTER 

 

To enable you to work with selections of employees when giving pay rises, reviewing absence, or 

sending letters for example. 

 

QUERY 

 

A tool which enables you to export a selection of employee data into MS Excel for example. 

ARCHIVE 

 

When an employee leaves, we can move their record to the another Database which is set up to 

specifically store leavers. This is called the Archive Database. 

 

USERNAME 

 

The unique name assigned to the person using Personnel Manager  

 

WIZARD  

 

A tool which guides you step by step guide through a process of screens 

VBT Vizual Business Tools 
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Appendix 2 - Contacts 
 

 

Agathon Consulting ltd 
 
If you have any queries relating to Personnel Director if you require additional training or consultancy, please 

contact Agathon Consulting by: 

 

Phone: 01242 663974 
 
Email: enquiries@agathonhr.co.uk 
 

Web: http://agathonhr.co.uk 
 

 
  

 


